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 Welcome

Congratulations on your decision to purchase Dolphin Imaging. You are about to use the best and most 
advanced imaging and diagnostic system in the world. With Dolphin Imaging, you will produce the best 
records, the most effective consultation presentations, and the most accurate cephalometric tracings. In 
addition, the Dolphin Imaging program is easy to operate.

This manual describes how to use Dolphin Imaging features to improve information flow in your practice. It 
describes how to capture patient images into the Dolphin Imaging program, perform cephalometric analy-
ses, modify images for patient presentations, and use treatment simulation and prediction tools.

Dolphin Imaging software is designed specifically for dental clinicians and trained assisting staff. Results 
produced by Dolphin’s diagnostic and treatment planning tools are dependent on the interpretation of 
trained and licensed practitioners.

Getting Training
To help you get the most out of your Dolphin Imaging system, we highly recommend the comprehensive in-
office training. You can also arrange to attend training in Dolphin’s California facility. Dolphin trainers are 
experienced and certified in clinical and treatment coordination. With this background, they are very knowl-
edgeable in how to enhance your practice by using the imaging and diagnostic tools that Dolphin Imaging 
provides. To arrange a training session, contact Dolphin.

Contacting Technical Support
If you need help, you can contact Dolphin in any of these ways:

By E-mail support@dolphinimaging.com: A support technician will respond to your message 
within 24 hours.

By Telephone Toll free from the US and Canada: 1 800.548.7241
Toll free from Australia: 1.800.881.011 (wait) 800.548.7241
Toll free from New Zealand: 000.911 (wait) 800.548.7241
From all other countries: +1 818.435.1368
Telephone support hours are 5:00 AM to 6:00 PM Pacific Time (8:00 AM to 9:00 PM 
Eastern Time). At other times, you may leave a message on our emergency pager by 
calling 1 818.687.6327.

By Fax +1.818.435.1369

Web site www.dolphinimaging.com : provides the latest product information and a list of local 
Dolphin representatives.
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Typographical Conventions
File names and directory names: These are shown in Courier. For example:

The dolphin.ini file contains system settings for the Dolphin Imaging software.

Optional parameters and variables: Optional parameters appear in square brackets ([]). Variables that 
you replace with actual values are shown in italic courier. In the following example:

File#=Label, Format, [BitsPerPixel,] FileFormula
   [ExitRoutineBatchFile=PathName]

Label, Format, BitsPerPixel, FileFormula, and PathName are all variables that you replace with 
actual values. BitsPerPixel and ExitRoutineBatchFile=PathName are optional parameters, which 
you may omit.

Keyboard combinations: Keys that you press together are shown with a plus sign between them. For 
example:

Press ALT+A
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1 Installing Dolphin Imaging

As of version 12, Dolphin Imaging is a 64-bit application. Whereas previous versions could only use 2GB of 
RAM regardless of how much memory your computer had, Dolphin Imaging can now use up to 2 billion 
times as much memory. As a result Dolphin Imaging can load larger DICOM datasets, larger digital model 
files, and so on. This 64-bit version is also faster at loading high-resolution camera photos (though we still 
recommend setting your camera to no more than five megapixels for optimal images and optimal perfor-
mance). The Email feature now supports both the 32-bit and 64-bit editions Microsoft Outlook, and the Dol-
phin Letter System now supports both the 32-bit and 64-bit editions of Microsoft Word.

Because of Dolphin Imaging's database structure, several components must be installed before the imag-
ing software. There are times when user interaction is required, so it is very important that you follow 
along with the instructions.

Depending on your system configuration, a technician may need to work with you during the installation:

● If the workstation that you’re upgrading is stand-alone (not on a network), you can install the 
software without a technician’s help.

● If you run Dolphin Imaging over a network, you may need the assistance of a local technician to 
prepare your network for the database components. Have your local technician call Dolphin for 
requirements prior to their visit to your office. This helps the installation process in a couple ways: 
○ The tech will be better prepared for their visit. 
○ Dolphin can find out when your technician will be visiting your office so that a Dolphin 

technician can be available if needed.

The core database installation can take between 15-25 minutes, so please make sure that you have ample 
time before beginning installation. 

Before installing, please note the following requirements for installation. For more information on minimum 
system requirements and recommendations, go to www.dolphinimaging.com/req.

● You can mix Dolphin Imaging 12 with Dolphin Imaging versions 10.0 or later; you are not required to 
upgrade all computers in your practice at once. However, you cannot mix Dolphin Imaging 12 with 
Dolphin Imaging versions earlier than 10.0.

● Your computer must meet the minimum system requirements for installing Dolphin Imaging. 
● If you are installing on a computer running Microsoft Windows Server, you need to install the 

following prerequisite features, which are included with Server but not automatically installed:
○ Microsoft .NET
○ Windows installer
○ Windows PowerShell 
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Licensing
● Dolphin Imaging 12 is not compatible with Dolphin Aquarium versions earlier than version 3. If you 
have Dolphin Aquarium, please upgrade to version 3 before installing Dolphin Imaging 12.

In addition, please review the following recommendations:

1 As with any major upgrade, please perform a complete backup of your system before installing the 
new software!

2 Shut down any open programs before beginning the installation.
3 If you are using Dolphin Imaging over a network, make sure that the imaging software has been 

closed on all the workstations. Install this update on the station where your patient files are stored 
(the server) before updating the other workstations!

Licensing
If you are currently using a licensing scheme that uses USB security dongles and mail-in registration num-
bers, you need to upgrade to the DOLI licensing system, which deploys licenses to you automatically 
through the Dolphin Update Service. Please review the following frequently-asked questions to determine 
whether you need to upgrade to the DOLI licensing scheme.

How can I tell which type of licensing I have currently?

In most cases, practices that have not yet upgraded to the DOLI licensing have a black or purple security 
key plugged into the USB port on the computer running Dolphin Imaging. The following picture illustrates 
the purple USB Dolphin security key. 

Within Dolphin Imaging, practices that have not yet upgraded to DOLI licensing will see a Module Activa-
tion option on the Tools menu accessible from the Dolphin Imaging main screen. However, practices that 
use DOLI licensing will see a Dolphin Licensing option on the Tools menu instead. For more information, 
see “Viewing and Updating Licenses” on page 3-73 of the Dolphin Imaging User’s Guide. 

How do I go about upgrading to DOLI?
1 Contact Dolphin Inside Sales (see http://www.dolphinimaging.com/Contact/RegionalMap) to request 

the upgrade. Dolphin will arrange for the DOLI licensing software to be downloaded to your computer 
using the Dolphin automatic update service (DUS). 

2 Once the upgrade has been downloaded and installed, verify that the system is working properly.
3 Mail your security dongle back to Dolphin.
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Licensing
Are there any circumstances in which I must upgrade to DOLI?

Yes. DOLI is required for all Dolphin Imaging installations starting with version 12. Starting with version 12, 
Dolphin Imaging is not compatible with the dongle-based licensing scheme.

Does DOLI support “floating” licenses?

Yes, as long as all the licenses are on the same office network (for example, if your office purchased five 
licenses that float between twelve computers on your office network). If you have more than one office net-
work, each network must be licensed separately. If you have more than one office network, contact your 
Dolphin sales representative for multi-office licensing details.

How can I find out what DOLI licenses I have?
1 From the Dolphin Imaging main screen, select Dolphin Licenses... from the Tools menu.

The Dolphin Imaging Licenses dialog box opens and lists the licenses you have purchased.

For more information, see “Viewing and Updating Licenses” on page 3-73 of the Dolphin Imaging 
User’s Guide.

How can I get additional DOLI licenses?

You can add previously-unlicensed modules (such as the Dolphin 3D Orthognathic Surgical Planning mod-
ule). In addition, you can increase the number of floating licenses you have for modules that limit the num-
ber of concurrent users. 

1 Contact Dolphin Inside Sales (see http://www.dolphinimaging.com/Contact/RegionalMap) to 
purchase additional licenses. 

Dolphin will authorize the new licenses to be downloaded to your computer.

2 Download the new licenses to your computer.

To update your licenses from within Dolphin Imaging:

a From the Dolphin Imaging main screen, select Dolphin Licenses... from the Tools menu.
b Click Refresh Licenses.

To use the Dolphin automatic update service (DUS) to update your licenses:

a Click the DUS icon ( ) in the Microsoft Windows tray.

b In the Dolphin Update Service dialog box, click the About tab.
c Click Refresh License.

Do I have to be connected to the Internet to use my DOLI licenses?

No. Once you have downloaded your licenses, you don’t need to maintain an Internet connection to use 
them. An Internet connection is only required to download newly-purchased licenses.
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Using Microsoft SQL Server Standard Edition
Using Microsoft SQL Server Standard Edition
Dolphin Imaging includes Microsoft SQL Server Express, which is a free edition of SQL Server. If you have 
a large practice, however, you may prefer to purchase and use the standard edition of Microsoft SQL 
Server. In this case, you need to install it before installing Dolphin Imaging.

Generally speaking, you should follow the installation instructions provided by Microsoft for the version of 
Microsoft SQL Server Standard Edition that you are installing. There are, however, a few instances where 
you need to make specific choices or enter information to enable Dolphin Imaging to connect to your SQL 
Server database. 

To install Microsoft SQL Server Standard Edition for use with Dolphin Imaging:
1 Launch the Microsoft SQL Server Standard Edition installation.
2 Follow the installation program's prompts to begin installing Microsoft SQL Server Standard Edition.
3 When the Feature Selection dialog box appears, make sure that the following features are selected: 

Database Engine Services, Client Tools Connectivity, Client Tools Backward Compatibility, and 
Management Tools-Complete.

4 When the Instance Configuration dialog box appears, select Named Instance and enter Dolphin in 
the field.

Dolphin Imaging expects the database instance to be named Dolphin, so using this name enables 
Dolphin Imaging to find the database without further configuration. If you name the database 
instance something else, you will need to explicitly configure Dolphin Imaging to use that name for its 
database. For more information, see “Troubleshooting” on page 1-17.

5 When the Server Configuration dialog box appears, set up accounts as follows:

6 When the Database Engine Configuration dialog box appears, enter the following options:
○ Select Mixed Mode as the Authentication Mode.
○ Enter a strong password for the SQL Server system administrator account. A strong password 

is 1-128 characters long and includes letters, digits, and symbols.
○ Specify the SQL Server administrators. You can click Add Current Account to add your 

account as a server administrator. If you are not presently logged in using the Domain account 
created for Dolphin, make sure to add that account as well.

7 Follow the installation program's prompts to complete the Microsoft SQL Server Standard Edition 
installation.

8 Once you have completed the installation, call Dolphin to have the Server administrator's password 
changed.

Service Account Name Startup 
Type

SQL Server Database 
Engine

Local System or Domain\Administrator, where Domain 
is the name of your domain (for example, Dolphin)

Automatic

SQL Server Browser NT AUTHORITY\Network Account Automatic
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Starting the Dolphin Imaging Installation
Starting the Dolphin Imaging Installation
Depending on the number of computers in your practice, you may need to install Dolphin Imaging on the 
following types of workstations:

You can install Dolphin Imaging on any type of workstation (stand-alone, database server, or client) by fol-
lowing the procedure described in “Typical Installation” below.

If your practice uses a Dolphin database server and several client workstations, you can automate the 
installation and update processes as described in “Automating Dolphin Imaging Installation and Updates” 
on page 1-14.

Typical Installation

You must use this procedure when you initially install Dolphin Imaging on a stand-alone workstation or a 
Dolphin database server. You can also use this procedure to install Dolphin Imaging on client workstations.

To start the installation:
1 Close any open programs.
2 Choose one of the following methods to start the installation process.

○ Place the installation DVD into your DVD drive. The installation will begin automatically. If the 
DVD was already inserted when the computer booted up, eject and reinsert the DVD to begin 
installation.

○ Start the installation process from Windows Explorer by selecting Computer or This PC. Then, 
double-click the Dolphin DVD icon. Installation should begin within a few seconds.

The Welcome dialog box appears and lists options for installing the software, viewing the 
documentation, and installing prerequisite software (Internet Explorer and Adobe Reader). If you 
need to install Internet Explorer, the installation program will prompt you to do so.  For information on 
viewing the documentation and installing Adobe Reader, see Chapter 2, Introduction to Dolphin 
Imaging in the Dolphin Imaging User’s Guide.

3 Click Install Dolphin.

The Dolphin Imaging installation procedure starts.

Stand-alone workstation Typically used in practices that only need one computer running Dolphin 
Imaging. A stand-alone workstation has everything you need to use the 
Dolphin Imaging program. Although the Dolphin database resides on this 
computer, other computers cannot access it.

Dolphin database server Typically used in practices that need several computers running Dolphin 
Imaging and sharing patient data in a single Dolphin database. The 
Dolphin database resides on this server, and other Dolphin Imaging 
workstations (clients) access the database over the network. You can also 
use the Dolphin Imaging program on this computer.

Client workstation Typically used in practices that need several computers running Dolphin 
Imaging and sharing patient data in a single Dolphin database. Client 
workstations running Dolphin Imaging all share patient data in a single 
Dolphin database residing on the Dolphin database server. 
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Starting the Dolphin Imaging Installation
4 Follow the instructions on the installation dialog boxes until the following dialog box appears:

5 Select the type of workstation on which you are installing Dolphin Imaging. Then, click Next >.

Select from the following options:

If you are installing the Dolphin Imaging software on a stand-alone workstation or a networked 
workstation that is the Dolphin SQL database server and you have already installed Microsoft SQL 
Server, the following dialog box may appear. If it does, see “Troubleshooting” on page 1-17 for 
information on how to resolve the issue.

Client/Workstation Select this option if you are installing Dolphin Imaging on a networked 
workstation that is not the Dolphin database server.  If you select this 
option, continue your installation with “Installing the Dolphin Imaging 
Software” on page 1-10.

Server/Stand-alone Select this option if you are installing Dolphin Imaging on a a stand-alone 
workstation or on a networked workstation that you want to use as the 
Dolphin database server.  If you select this option, continue your 
installation with “Installing the Database Components” on page 1-8.
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Starting the Dolphin Imaging Installation
If you are installing the Dolphin Imaging software on a networked workstation, you may need to work 
with a Dolphin support technician. The following dialog box gives you the option of exiting the 
installation procedure so that you can make an appointment with a Dolphin support technician.
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Starting the Dolphin Imaging Installation
6 Click Yes to continue the installation procedure on your networked workstation.

Or,

Click No to exit the installation procedure.

If you click No, the installation procedure exits. Once you have made an appointment with a Dolphin 
support technician, you can start the installation procedure again.

Installing the Database Components

Dolphin Imaging includes Microsoft SQL Server Express, which is a is a free edition of SQL Server. The 
instructions below describe how to install it as part of your Dolphin Imaging installation.

Note: If you have a large practice, however, you may prefer to purchase and use the standard edition of 
Microsoft SQL Server. In this case, you should have installed it before installing Dolphin Imaging 
as described in “Using Microsoft SQL Server Standard Edition” on page 1-4, and you should skip 
this section.

To install the database components:

If you are installing the Dolphin Imaging software on a stand-alone workstation or on a network workstation 
that is the database server, you see several progress dialog boxes as various database components are 
installed. Installing the database components may take several minutes. When the database component 
installation completes, the following dialog box appears:
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Starting the Dolphin Imaging Installation
This dialog box is the beginning of the Dolphin Imaging software installation. Continue your installation as 
described in “Starting the Dolphin Imaging Installation” on page 1-5.

Note: If this is the first time you are installing Dolphin Imaging, SQL Server Management Studio Express 
will be installed along with Microsoft SQL Express.

Enabling Multi-byte Characters

If you are running the Russian, Chinese, or Japanese version of Microsoft Windows, you can use Dolphin 
Imaging's multi-byte character support to enter patient data using Russian, Chinese, or Japanese charac-
ters. 

Note: Enabling multi-byte character support requires the assistance of a Dolphin Support representative. 
Also, multi-byte character support is not compatible with Dolphin Management, Mobile, or the 
Security Utilities.

If you are installing the Dolphin Imaging software on a network server or stand-alone workstation running 
Microsoft Windows in Russian, Chinese, or Japanese, a prompt similar to the following will appear during 
installation. This prompt does not appear on networked workstations that are not network servers.

To respond to this prompt:
1 Optionally, check the Don't show this message again box.

If you check this box, this message won't appear in future installations on this computer.

2 Click OK.

If you do not want to enable multi-byte character support, you can simply continue with the installation.

If you want to enable multi-byte character support, contact your Dolphin Support representative for assis-
tance in making the necessary modifications to your Dolphin Imaging database.
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Starting the Dolphin Imaging Installation
Installing the Dolphin Imaging Software

The Choose Destination Location dialog box shown below is the beginning of the Dolphin Imaging soft-
ware installation.

To install the Dolphin Imaging software:
1 If you are installing the software on a networked workstation that is not the Dolphin server, follow the 

instructions on the installation dialog boxes until the following dialog box appears:
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Starting the Dolphin Imaging Installation
If you are installing the software on a stand-alone workstation or on a networked workstation that is 
the Dolphin server, this dialog box does not appear, and you should skip the next step.

2 If you are installing the software on a networked workstation that is not the Dolphin server, enter the 
name of the server followed by a back-slash (\) and the instance (typically “DOLPHIN”). For example, 
you might enter SERVER\DOLPHIN. Then, click Next.

3 Follow the instructions on the installation dialog boxes to install the software.
4 On the last installation dialog box, click Finish.

Installing the Security Utilities

The Security Utilities are a set of optional utilities that you may want to install to comply with national pri-
vacy acts such as HIPAA. These utilities include the following features:

● The ability to require Dolphin Imaging users to log in before they can use the software.
● The ability to set up employee login IDs and associate rights with them. This protects patient privacy 

by restricting access to various Dolphin Imaging features to authorized employees only.
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Starting the Dolphin Imaging Installation
You need to install the Security Utilities in order to access the following features, which are shared with 
Dolphin Management: Database Log, Document Organizer, Dolphin Ocean Client Administration1, Loca-
tion Rights1, Employee Rights1, Employee Types1, Employees1, Locations1, My Orthodontist, One-Page 
Questionnaire1, Password Setup1, Patient Add and Edit (Dolphin Management interface)1, Referring Doc-
tors (Dolphin Management interface)1, Reset Locks1, SMS/Email Manager1, Super Questionnaire1, and 
Treatment Card1. 

If you want to install the Security Utilities, you can do so after you have installed Dolphin Imaging. If you 
want these utilities, bear the following considerations in mind:

● If you install the Security Utilities, you must install them on every Dolphin station on your network.    
● If you use the Dolphin Practice Management System, please contact Dolphin support to enable the 

Security Utilities instead of installing them from the Dolphin Imaging installation media. 
● The Security Utilities require that the Dolphin database be set to SQL Server 2005 (90) compatibility 

or higher. If you are not running the required SQL server or the Dolphin database SQL Server 
compatibility is set incorrectly, a message box appears and the installation fails. For information on 
resolving the problem, see “Microsoft SQL Server Compatibility” below. 

To install the Security Utilities:
1 On the installation program's Welcome dialog box, click Install Dolphin Premium Security Utilities.
2 Follow the instructions on the installation dialog boxes to install the utilities. 

After installing and before you set up your own employees and passwords, you can log into Dolphin Imag-
ing using a default account. The default user name is admin and the password is admin. 

Microsoft SQL Server Compatibility

If you were unable to install the Security Utilities:

● Make sure you are running a supported version of Microsoft SQL Server. For information on 
supported versions, go to www.dolphinimaging.com/req.

● Make sure that the compatibility level of your Dolphin database is set correctly.

You can use Microsoft SQL Server Management Studio or Microsoft SQL Server Management Studio 
Express to change the compatibility level of your Dolphin database as described below. Microsoft SQL 
Server Management Studio or Microsoft SQL Server Management Studio Express is installed when you 
install the Microsoft SQL Server. 

1. Before a Dolphin Imaging user can access this feature, the associated Employee Right must be granted to 
that user’s account. For more information, refer to the Dolphin Management User Guide or Dolphin Man-
agement online help (Dolphin Management User Guide.PDF or DM_Help.chm in your C:\Dolphin 
folder)
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Starting the Dolphin Imaging Installation
To change the compatibility level of your Dolphin database:
1 Launch Microsoft SQL Server Management Studio or Microsoft SQL Server Management Studio 

Express.

To launch the appropriate program:

a On the Start menu, select the version of Microsoft SQL Server installed on your computer. 
b Select Microsoft SQL Server Management Studio or Microsoft SQL Server Management 

Studio Express.
2 On the Connect to Server dialog box, select your Dolphin database server from the Server name 

drop-down list.

For example, your Dolphin database server might be called MYCOMPUTER\DOLPHIN.

3 Click Connect.
4 In the Object Explorer pane, click the plus sign (+) next to Databases to see the available databases.
5 Right-click DolphinPlatform under Databases, and select Properties from the context menu.
6 In the Select a Page pane, click Options.
7 From from the compatibility level drop-down list, select the version of SQL Server that you have 

installed. Then, click OK.
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Starting the Dolphin Imaging Installation
Once you have changed the compatibility level of your Dolphin database, you need to stop and start the 
SQL Server for the change to take effect.

To stop and start the SQL Server:
1 In the Object Explorer pane, right click your Dolphin database server (for example, 

MYCOMPUTER\DOLPHIN). Then, select Stop to stop the SQL Server.
2 Click Yes on the confirmation message that appears to stop the SQL Server.
3 In the Object Explorer pane, right click your Dolphin database server again. Then, select Start to 

start the SQL Server.
4 Click Yes on the confirmation message that appears to start the SQL Server.
5 Select Exit from the File menu.

Once the SQL server is restarted, you can retry the Security Utilities installation.

Automating Dolphin Imaging Installation and Updates

Dolphin Imaging offers an unattended installation process that you can use to automate installation from a 
DVD onto several workstations. When installing Dolphin Imaging for the first time, you can only perform 
unattended installations on client workstations (not on stand-alone workstations or the Dolphin database 
server).

Before installing Dolphin Imaging on the client workstations:

1 Complete the installation of your Dolphin database server, making sure to specify a network path and 
not a local path for the Dolphin Imaging working folder.

For information on installing Dolphin Imaging on the Dolphin database server, see “Typical 
Installation” on page 1-5.

2 Copy the contents of the Dolphin Imaging installation DVD to a network location that is accessible by 
all client workstations.

Once these steps are complete, you can install Dolphin Imaging on the client workstations, typically using 
some type of network deployment tool.

To perform an unattended installation on the client workstations:
1 Copy the DOLPHIN.INI file from C:\Windows folder of the Dolphin database server to the 

C:\Windows folder on each client workstation.

The DOLPHIN.INI file contains system settings for the Dolphin Imaging software. Since the Dolphin 
Imaging software maintains many program settings individually for each workstation, each 
workstation needs to have its own copy of this file. For more information, see Appendix C, 
DOLPHIN.INI File in the Dolphin Imaging User’s Guide.

2 Execute the Dolphin Imaging installation on each client workstation using the following command 
line: 

\setup.exe /z"/accepteula"
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Installing the Dolphin Letter System
You can also use your network deployment tool to automate updates whenever a new software version is 
downloaded by the Dolphin Update Service.

To perform an automated update:
1 Execute the Dolphin Imaging update procedure from within the working\data\dus\updates 

folder on the Dolphin database server using the following command line:

DIUP*.exe -ap "/z"/accepteula""

Installing the Dolphin Letter System
The Dolphin Letter System (DLS) is an optional module that simplifies and automates generation of referral 
and patient letters. Every letter can include your patient’s digital pictures. You can choose from dozens of 
pre-defined, professionally written correspondence templates or easily customize your own. 

To install DLS:

1 Close any open programs.
2 Choose one of the following methods to start the installation process.

○ Place the installation DVD into your DVD drive. The installation will begin automatically. If the 
DVD was already inserted when the computer booted up, eject and reinsert the DVD to begin 
installation.

○ Start the installation process from Windows Explorer by selecting Computer or This PC. Then, 
double-click the DLS DVD icon. Installation should begin within a few seconds.

3 When the installation program prompts you for the folder in which your Dolphin Imaging data is 
stored, click Next> if you are using the default folder (C:\Dolphin\Working).

Or,

If you are not using the default folder to store your Dolphin Imaging data, enter the location of the 
folder, and click Next>.

The installation program installs the DLS software.

Using an Encrypted SQL Connection
Using encryption on the connection between Dolphin Imaging and your SQL Server database provides an 
additional level of data security. Using encryption is optional. If you want to use encryption, you must 
explicitly enable it in your DOLPHIN.INI file, which contains system settings for the Dolphin Imaging soft-
ware. 

Note: Encryption is supported for Microsoft SQL Server Express (the free edition of SQL Server that is 
included with Dolphin Imaging) and for the standard edition of Microsoft SQL Server.
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Getting Software Updates
To enable encryption:
1 Add the following line to the [Environment] section of your DOLPHIN.INI file:

AddlConnString=Encrypt=True;TrustServerCertificate=True

This should be on a single line in the DOLPHIN.INI file. 

For more information, see Appendix C, DOLPHIN.INI File in the Dolphin Imaging User’s Guide.

Getting Software Updates
When you install the Dolphin Imaging software, the Dolphin Update Service (DUS) is automatically 
installed. This service automates Dolphin software updating. If your practice uses DOLI licensing (see 
“Licensing” below), DUS is also used to deliver newly-purchased DOLI licenses.

Note: DUS does not support global DOLPHIN.INI configurations. To use DUS:

■ A DOLPHIN.INI file must reside in the C:\Windows directory.

■ If you are using a global DOLPHIN.INI file, the [Environment] section in the global 
DOLPHIN.INI should also be in the local copy of the DOLPHIN.INI file.

■ The SYS setting in the [Environment] section of DOLPHIN.INI must point to the 
directory where Dolphin software is installed on the computer. Once installed, DUS reads 
the local DOLPHIN.INI. By design, it looks in the C:\Dolphin folder for a 
DOLPHIN.INI file. If it does not find it there, it looks in the C:\Windows folder for the 
DOLPHIN.INI file.

For more information on the DOLPHIN.INI file, see Appendix C, DOLPHIN.INI File in the Dolphin 
Imaging User’s Guide.

To install DUS:
1 Go to www.dolphinimaging.com/dus.
2 Follow the instructions to download and install the service.

After DUS is installed, the DUS icon ( ) appears in the Microsoft Windows tray. 

If you see this icon blinking:

1 Point to  with your mouse and follow the instructions that appear.  
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Troubleshooting
This section describes how to resolve some issues that might arise during or after installation.

Issues During Installation
If you are installing the Dolphin Imaging software on a stand-alone workstation or a networked workstation 
that is the Dolphin SQL database server and you have already installed Microsoft SQL Server, the follow-
ing dialog box may appear during the Dolphin Imaging software installation.

To resolve this issue:
1 Select the third option.
2 Provide the password for an existing SQL Server instance and use it for Dolphin. Then, click Next >.
3 Select the SQL Server database instance from the drop-down list.
4 Enter the Server administrator's password.

For information on how the SQL Server database instance name and Server administrator's 
password were originally set up, see “Using Microsoft SQL Server Standard Edition” on page 1-4.
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Issues After Installation
You may see the following error message when you try to launch Dolphin Imaging after installation:

To correct this error:
1 Select Windows Administrative Tools from the Start menu.
2 Select Services.

The Windows Services dialog box opens.

3 If the database service SQL Server (Dolphin) is present but its status is not Running, follow the steps 
under “To correct this error if the database service is present but not running:” below.

Or,

If the database service SQL Server (Dolphin) is present and its status is Running, follow the steps 
under “To correct this error if the database service is present and running:” below.

Or,

If the database service is not present, follow the steps under “To correct this error if the database 
service is not present:” on page 1-20.
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To correct this error if the database service is present but not running:
1 Right-click the database service and select Start from the context menu.
2 Launch Dolphin Imaging.

If Dolphin Imaging still won't launch, follow the steps under “To correct this error if the database 
service is present and running:” below.

To correct this error if the database service is present and running:
1 Select Windows Administrative Tools from the Start menu.
2 Select Computer Management.
3 In the left pane of the Computer Management dialog box, expand Services and Applications. 
4 Expand SQL Server Configuration Manager.
5 Expand SQL Server Network Configuration.
6 Click Protocols for Dolphin.
7 Make sure that Named Pipes and TCP/IP are both enabled (see below).
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8 If either of these protocols is disabled, right-click it and select Enable from the context menu.
9 Click SQL Server Services.
10 Right-click SQL Server (DOLPHIN) and select Restart from the context menu.

To correct this error if the database service is not present:
1 Make sure that your computer meets the minimum requirements for Dolphin Imaging (see 

www.dolphinimaging.com/req).
2 Make sure your computer has all latest high priority Windows updates installed (see http://

update.microsoft.com).
3 In the Microsoft Windows Explorer, right-click C:\Dolphin, and select Properties from the context 

menu.
4 On the Dolphin Properties dialog box, click the Security tab.
5 Click Edit....
6 Select Everyone or Authenticated Users.
7 Check the Full Control box. Then, click OK.
8 Delete the DOLPHIN.INI file from the C:\Dolphin and C:\WINDOWS folders.

The DOLPHIN.INI file contains system settings for the Dolphin Imaging software, and it is installed 
in both your Dolphin and Windows folders. For more information, see Appendix C, DOLPHIN.INI 
File.

9 Re-run the Dolphin Imaging installer from the distribution DVD.
10 In the Microsoft Windows Explorer, right-click C:\WINDOWS\DOLPHIN.INI. Then, select Properties 

from the context menu.
1-20 Dolphin Imaging Installation Guide DI_INSTALL_GUIDE-12 rev. 1.0

http://dolphinimaging.com/requirements.html
http://www.dolphinimaging.com/req
http://update.microsoft.com
http://update.microsoft.com


Troubleshooting
11 On the Dolphin Properties dialog box, click the Security tab.
12 Click Edit....
13 Select Everyone or Authenticated Users.
14 Check the Full Control box. Then, click OK.
15 Launch Dolphin Imaging.
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